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INTRODUCTION 
Gallagher MyScale Pro is a valuable accessory to your Weigh Scale W610. 

MyScale Pro is software that can be run on a personal computer.  After a 
connection has been made between the computer and the Weigh Scale, MyScale 
Pro can process information obtained from the Weigh Scale. The Weigh Scale 
does not have to be connected to the loadbars for this interaction. 

With MyScale Pro you can perform the following functions; 

 Copy sessions from the Weigh Scale. 

 View and Edit sessions. 

 Edit links between Electronic IDs and Visual Tag Numbers. 

 View and edit animal traits recorded during a Weighing Session. 

 Prepare advanced session statistics, reports and graphs using records 
imported from the Weigh Scale. 

 View animal weight gain graphs. 

 Export sessions to the Weigh Scale. 

 Email sessions to selected and user defined recipients. 

 Print sessions. 

 Display date of weighing for each record and use this date when creating 
weight gains graphs. 

 Draft limits are transferred to MyScale Pro from the Weigh Scale.  The Draft 
limits are saved with the record and can be viewed. 

 Create reports. 

 
If you have a Gallagher SmartReader, you can: 

 Transfer sessions from the SmartReader. 

 Create long term record storage using MyScale Pro to backup information 
from the SmartReader. 
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INSTALLATION 

Operating systems 
You can run MyScale Pro on either of the following operating systems: 

 Windows XP 

 Windows 2000 
 

Installation procedure 
Ensure you install the most recent version of MyScale Pro each time you 
purchase new hardware from Gallagher. 

Before installing the MyScale Pro software, make sure that you close any open 
applications on your computer.  

Note: The MyScale Pro software only needs to be installed once and other 
products use the same version. If you are installing over a previous version, see 
Installing over a previous version (p 5). 

1. If installing MyScale Pro from CD. Insert the MyScale Pro software CD into 

the CD Drive on your computer. The Installer screen displays. 

 
2. Select the appropriate option from the list provided. MyScale Pro is able to 

be installed to accommodate both Gallagher and Ruddweigh products. 

3. Click Install MyScale Pro. The Welcome to the Install Wizard for 
MyScale Pro screen displays.  
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4. Click Next. The Select Country screen displays.  

 
5. Check the box next to your country. If your country is not displayed, select 

Other. 

This option sets some of the language and terminology used, as well as the 
weight units. In the USA and Canada options, the default weight unit is 
pounds. In all other countries, the default weight unit is kilograms. The 
weight unit selection can be changed after installation. 

Note: If the appropriate language file is not available, the language will 
default to English. The language can be altered at any time. See Change 
MyScale Pro's language setting (p 14). 

Note:  The date format selected in the Operating System is the same date 
format that will be displayed in MyScale Pro. E.g. If the selected country is 
USA, the date format for the record date in session files and reports  will 
only  display as MM/DD/YYYY, if this is the date format selected in the 
Operating System.  

6. Click Next. The License Agreement screen displays. 

7. Select I accept the terms of the license agreement, and click 
Next. The Choose Destination Location screen displays. 

8. Do you want to change the Destination Folder? 
 If yes, click Browse and select a new folder.  
 If no, go to next step.   

The Destination Folder is the folder in to which the MyScale Pro 
program files install.  



   3E2398  MyScale Pro W610 User Manual 

 

Page 4 

 

9. Click Next. The Select Hardware screen displays. 

 
10. Check the box next to the hardware you have. 

The options you select determine what options are installed on the Main 
menu. 

11. Click Next.  
If installing MyScale Pro from CD, you are now given the option of storing 
the tutorials on your computer hard drive. If installed, the files will take 
approximately 40 MB of disk space. 

 
Note: The tutorials include demonstrations of the Scale Model 800 hardware 
as well as interactive tutorials of MyScale Pro. 



3E2398  MyScale Pro W610 User Manual   

 

  Page 5 

 

12. Click Next. The Setup Status screen displays while the program files are 
installed on your computer.  

If this computer does not have the USB to Serial Driver to support a USB 
to Serial cable (should one be required) a screen displays. 

 Click Next to install the required USB to Serial Driver. The License 
Agreement screen displays. 

 Select I accept the terms of the license agreement, and click 
Next.The driver files are installed on your computer. 

13. Click Finish. 

14. Do you want a MyScale Pro icon on your desktop? 

 If yes, go to next step. The check box on the InstallShield Wizard 
Complete screen is already selected. 

 If no, remove the tick from the check box, Yes, I want a shortcut to 
MyScale Pro on my desktop. 

15. Click Finish and then click Exit. 

16. Remove the MyScale Pro CD from the CD drive. 

To manually start the installation, complete the following steps:  

 Select Run from the Windows Start menu.  

 Type d:\setup (where d is your CD Drive) 

 Click OK.  
 

Installing over a previous version 
Ensure you install the most recent version of MyScale Pro each time you 
purchase new hardware from Gallagher. 

The InstallShield Wizard detects if you already have a version of MyScale Pro 
installed on your computer.  This will automatically be updated with this later 
version of the software. 

Note: Updating this version of MyScale Pro will retain the data previously 
recorded and still enable full access to view and edit. 

To manually start the installation, complete the following steps:  

 Select Run from the Windows Start menu.  

 Type d:\setup (where d is your CD Drive) 

 Click OK.  
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Connecting the computer to the Weigh Scale 
You need to establish a connection between the computer and the Weigh Scale 
when you want to carry out any of the following tasks: 

 Copy sessions from the Weigh Scale to the computer. 

 Copy session files from the computer to the Weigh Scale. 

 Update links between Electronic IDs and Visual Tag Numbers. 

Note 1: When your Weigh Scale is connected to your computer, the Weigh Scale 
may not function correctly to every user input. During the period of connection, 
use only the computer for transactions. 

Note 2: A message will be displayed if an older version of MyScale Pro is used to 
communicate with a more recent release of the Weigh Scale software. If this 
occurs, the most recent version of MyScale Pro software will need to be installed.  
See Installing over a previous version (p 5)  for more details. 
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Procedure ‐ Connecting the computer to the Weigh Scale 
To establish a connection between the computer and the Weigh Scale, follow 
these steps: 

1. Prior to connection, configure the port on the Weigh Scale by following 
these steps: 

 Turn the mode select switch to S. 
 Select COMMUNICATIONS. 

 Press the   button to select the port to which the serial cable 
is connected (usually Port 1). 

 Press the   button repeatedly until Computer displays.  
If Computer is already selected for the other port it won't display in 
the options for this port. Select the other port and change it to a 

different option, for example, Unused. 

Press  . 

Leave the Weigh Scale turned on. 

2. Connect one end of the serial cable supplied with your Weigh Scale to a 
serial port on the computer. Connect the other end to the port on the Weigh 
Scale that you have just selected. 
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Connecting the computer to the SmartReader 
If you own a Gallagher SmartReader, MyScale Pro enables you to transfer 
Electronic ID tag numbers stored in the SmartReader memory into MyScale Pro. 

You need to establish a connection between the computer and the SmartReader 
in order to transfer sessions from the SmartReader to the computer. 

To connect the computer to the SmartReader, complete the following steps: 

1. Plug the supplied COM cable (RS232 to RS232) into the RS232 port on the 
SmartReader. 

2. Plug the other end into the serial port on your computer.   

Note:  If your computer does not have a serial port, use the supplied RS232 
to USB adaptor to connect to a USB port on the computer. 

 

SmartReader connection status 
MyScale Pro checks that a valid connection between the computer and 
SmartReader exists each time a request is made to access the reader. 

If text similar to the following is 
displayed... 

Then… 

Unable to connect to a Gallagher 
Reader. Ensure that your Gallagher 
Reader is connected to the computer 
and switched on. 

The computer has tried to connect to 
the SmartReader and has been unable 
to connect. 

Attempting to communicate with the 
reader.  Please wait.... 

The computer is attempting to 
connect to the SmartReader.    

The Gallagher SmartReader memory 
does not contain any session records. 

A valid connection with the 
SmartReader exists but there are no 
sessions on the SmartReader to 
transfer to the computer. 

Gallagher SmartReader connected 
and on line. 

The computer and SmartReader are 
correctly connected.  The download of 
sessions begins automatically.   

Note: Only closed sessions are 
transferred to the computer.  The 
current session is not transferred.   

Note: Sessions can only be transferred from the SmartReader into MyScale Pro if 
the SmartReader was operated in Memory Mode. 
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BASIC TERMINOLOGY 
There are terms and abbreviations used throughout this manual that relate 
exclusively to MyScale Pro and the use of Weigh Scale products. Some terms 
(such as "Session" and "Cross‐Reference Table") are defined and discussed in 
their own relevant chapters. 

The following terms will become familiar as you work through the process: 

Electronic ID  The Electronic Identification Tag is the electronic code in an 
ear tag that can be scanned to recognise an individual animal. 

Visual Tag 
Number 

Visual Tag Number is the combination of letters and/or 
numbers printed on the ear tag to enable visual recognition of 
an individual animal or group of animals. This can be 
augmented by other options such as the colour of the tag. 
Often the Visual Tag Number is referred to in MyScale Pro as 

the Tag Number.  The Visual Tag Number can be up to 15 
characters in length. 

Loadbar  The device that detects the weight of the load and transfers 
this to the Weigh Scale. 

Weigh Scale  The digital display unit that detaches from the loadbar and 
connects to your Computer. 

QWERTY 
Keyboard 

The alphanumeric keyboard on the lower portion of the 
Weigh Scale. 

Record  A record is a piece of data relating to an animal. One animal 
may have many associated records. 
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STARTING MYSCALE PRO 
Connecting the SmartReader to the computer by cable 

To connect the SmartReader to a computer by cable, complete the following 
steps: 

1. Plug the supplied reader to RS232 cable into the SmartReader. 

2. Plug the other end into the serial port on your computer. 

Notes: 

 If your computer does not have a serial port, use the supplied RS232 to 
USB adaptor to connect to a USB port on the computer. 

 Connection via Bluetooth does not work for MyScale Pro. 

To Start MyScale Pro: 
Double‐click the MyScale Pro icon on the desktop. 

 

Alternatively... 
You can start MyScale Pro from the Windows Start menu. 

1. Click on the Windows Start button. 

2. Select All Programs (Windows XP) or Programs (Windows 2000). 

3. Select MyScale. 

4. Click on  . 
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CLOSING MYSCALE PRO 
To close MyScale Pro: 

Click on the Exit button or on the   at the top right of the screen. 

If you have copied a breeder defined Trait Session from the Weigh Scale and 
have not emailed this to the breeder association, the following prompt will 
be displayed: 

 
 Click Yes to email sessions prior to closing. 

 Click No to exit the program without sending sessions. 
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MYSCALE PRO MAIN MENU 
The list of hardware selected during installation determines what menu options 
display on the MyScale Pro Main menu.  If other hardware is connected to 
MyScale Pro, the associated menu options are also added to the Main menu.  All 
added menu options remain on the Main menu once added, however MyScale 
Pro checks each time to determine if the selected option is applicable to the 
connected hardware. 

Each group of hardware (Weigh Scale, DairyScale or Reader) has its own tab on 
the menu which is only displayed if selected during install or connected to 
MyScale Pro. 

The Localisation tab displayed on the Main menu, enables you to change the 
default (English) language setting on MyScale Pro. 

If you connect other models of Gallagher Weigh Scales or new Gallagher products 
to the computer, MyScale Pro dynamically updates available menu options.  Once 
these options are displayed they are always available. 

 

  

To select an option, click on the associated radio button and then click Next. 

Whenever a list is displayed in the Main menu, pressing the F5 key refreshes the 
list. 

Each option is described in detail in the following sections of this manual. 
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Scale connection status  
MyScale Pro checks that a valid connection between the computer and the 
Weigh Scale exists. 

If the text similar to the 
following is displayed... 

Then... 

 
 

A valid connection exists, click Next. 

The message changes to reflect the Weigh 
Scale model connected. 

 

Either the connection to the Weigh Scale is 
not established or the Weigh Scale has not 
been configured correctly.  
See Connecting the computer to the Weigh 
Scale (p 6) before continuing. 
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Change MyScale Pro's language  
1. From the main menu, select the Localisation tab. 

The following window will open. 

 

Note: The option 'Change the WeighScale's alternate language', 
is only displayed on the screen when 'Scale version W610 1.0.7 connected 
and online' or similar, is present.  

While the Weigh Scale and computer negotiate connection the user may see 
'Attempting to communicate with indicator, please wait'. If the user sees 
'No scale Connected' it means there is a communication problem between 
the Weigh Scale and the computer. Ensure that the communication settings 
on the Weigh Scale have computer selected and that the serial cable is 
properly connected to each device. 

2. Select Change MyScale Pro's language and click Next. 
A list of available languages installed with MyScale Pro will be displayed. 

3. If the required language is not displayed, click Add New. 
The Select Language File window will open. 

 Navigate to where you have placed the language file, using the arrow 

from the Look In: box. 
Note: Additional language files are available from 
http://www.gallagher.ams.com/lng. Please follow the online 
instructions to install the file. 

 Select the language file from the list and click Open. 
This language will now be displayed on the Available Languages list. 

4. Select your language from the Available Languages list, and click Next. 
The selected language will be installed and is displayed on the Localisation 
window. 

Important: Ensure the language set in MyScale Pro is the same as the 
language set on the Weigh Scale. 
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Change the Weighscale's alternate language 
This option adds a new language to the Weigh Scale. Once added, the language 
must be selected on the Weigh Scale to become operational. The Weigh Scale's 
default language is English. 

Note: This option is available for Weigh Scale model W610 & W810. 

1. From the main menu, select the Localisation tab. 

2. Select Change the Weighscale's alternate language and click 
Next. 
A list of available languages will be displayed. 

3. If the required language is not displayed, click Add New. 
The Select Language File window will open. 

 Navigate to where you have saved the language file, using the arrow 

from the Look In: box. 
Note: Additional language files are available from 
http://www.gallagher.ams.com/lng. Please follow the online 
instructions to install the file. 

 Select the language file from the list and click Open. 
This language will now be displayed on the Available Languages list. 

4. Select your language from the Available Languages list, and click Next. 
The selected language will be installed and is displayed on the Localisation 
window. 

5. Click Finish. 

The current alternate language will be displayed on the MyScale Pro Main 
Menu window. 

Important: You must now select this language on the scale.   
 

Opening MyScale Editor 
There are two options for opening the MyScale Editor: 

 Open session files in MyScale Editor 
This option allows you to open session files in the MyScale Editor.  Files can 
then be viewed or altered. 

 Open MyScale Editor 
This option allows you to open the MyScale Editor without having to open a 
session file. 
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Opening session files in MyScale Editor 
With the MyScale Editor closed, you can open session files in any of the following 
ways: 

 Selecting Open session files in MyScale Editor option on the 
MyScale Pro Main menu. 

 Checking   on the window 
that displays after transferring sessions from the Weigh Scale or 

SmartReader to the computer and then clicking Finish. 
 "Dragging and Dropping" from MS Explorer. 

With MyScale Editor open, you can open session files by: 

1. Select File > Open. The Open file window displays. Sessions from your 
Weigh Scale will be listed. 

2. If using a Gallagher SmartReader select the folder applicable to the product 

you are using, (e.g. for a SmartReader HR3, select the Reader - 
Handheld folder.  
For a SmartReader BR Series, select Reader - Panel folder). 

 
Note: If there are no session files in the selected MyScale folder you need to 
transfer sessions from the Scale or SmartReader to the computer. 

If you want to… then… 

open a single session 
file 

click on the file to select it and click Open. 

open several session 
files 

hold down the Ctrl key and click on each file.  
Each selected file is highlighted. Click Open. 

open a block of 
session files 

click on the first file in the block. Hold down the 

Shift key and click on the last file in the block.  
All files between the first and the last are 

highlighted. Click Open. 
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If you are using Microsoft Explorer to view the files in your MyScale Folder 
and have the MyScale Editor open at the same time, your screen may look 
like this: 

 
To open a .csv file that is in Explorer, click and hold on the name of the file 
that you wish to open and drag it into any area in the MyScale Editor 
window. 

When you drop a file onto the MyScale Editor the file opens. 
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SESSION FILES 

Overview 
Session files are created and placed into the MyScale folder when sessions are 
copied from the Weigh Scale. When sessions are transferred from the 
SmartReader, sessions are removed from the Reader and placed into the Reader 
sub‐folder in the the MyScale folder. 

The following describes what you need to know about session files when working 
with them on your computer or when copying them to or from the Weigh Scale 
or transferring them from the SmartReader. 

A Standard Session is where a Tag Number, Weight, and Condition Score can be 
recorded about an animal. 
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Naming format for Scale session files 
Each Scale session file name created by MyScale Pro has the following format: 

YYYY-MM-DD NAME.CSV. 

Where… Is the… Example…
YYYY  4 digit year  2006 

MM  2 digit month  06 

DD  2 digit day  24 

hh  2 digit hour in 24 hour format  13 

mm  2 digit minutes  15 

NAME  Name of the weighing session that will 
display on the Weigh Scale. The name varies 
depending on session type, as below; 

 

STANDARD 
SESSION 
NAME 

The name can contain up to 17 characters 
and is chosen by the user. All letters will be 
upper case. 

Note: 
When the Weigh Scale creates an unnamed 
session file, the name is automatically set to 
--. 

STEERS 

Note: There is a space between the date and the session name. 
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Naming formats for Reader session files 
Each Reader session file name created by MyScale Pro has the following format: 

YYYY-MM-DD hh-mm TITLEnn.CSV. 

Where… Is the… Example…
YYYY  4 digit year  2006 

MM  2 digit month  06 

DD  2 digit day  24 

hh  2 digit hour in 24 hour format  13 

mm  2 digit minutes  15 

TITLE  Session name.  Defaults to SESSION.  This can be 
changed once the session files have been 
transferred  to the computer. 

SESSION 

nn  A two‐digit number.  Used to uniquely identify 
sessions that are transferred to the computer at 
the same time. 

01 

02 etc. 

Note: There is a space between the date and the time and between the time and 
the title. 

 

Examples of valid formats 
The following are examples of valid Weigh Scale session file names. 

2004-01-25 15-20 STEERS 

2003-12-04 16-30 @1630 

Note: Although you didn't see the session start time on the Weigh Scale (unless 
the session has no user‐entered name) it is always stored with the session name. 

The following are examples of valid Reader session file names. 

2006-03-07 15-21 Session01 

2005-03-07 15-21 Session02 

2005-03-07 15-21 Session03 
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Examples of invalid formats 
The following session file names are invalid, for the reasons given. 

2003‐01‐25 30‐15 STEERS  "30" is an invalid hour. 

12‐15 2003‐01‐25 STEERS  The date must be placed before the time.  

 
 

Session file structure 
MyScale Pro creates session files in a comma separated values (CSV) format.  This 
means that, within each record of the session file, fields are separated from each 
other by a comma. 

Each of the session files in your MyScale folder will have a CSV file extension. 

 

MyScale Pro requires files to be in CSV format if you want to copy them back to 
the Weigh Scale. 

 

How session files are created on the computer 
Each time you download a session file to the computer, MyScale Pro either 
creates a new session file or replaces an existing session file, in the MyScale 
folder or Reader sub‐folder. 

To understand how this works: 

 The date and time that the session was created on the Weigh 
Scale/SmartReader, as well as the session name (if you gave it one) is used to 
create the session file name on the computer. 

 The file name is always in the same format, for example 2003-01-25 12-
15 STEERS. See Naming format for session files (p 19). 

 If a file of that name already exists in the MyScale folder or Reader sub‐
folder, it is replaced. 
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How sessions are created in the Weigh Scale 
When you are copying session files from the computer to the Weigh Scale 
MyScale Pro uses the session file name to make decisions how to copy the 
session file. 

The following rules apply: 

If the date and time in the 
session file name… 

Then… 

Matches the date and time of a session 
on the Weigh Scale. 

The session on the Weigh Scale will 
be replaced with the data from the 
session file. 

Does not match the date or time of 
any sessions stored on the Weigh 
Scale. 

A new session will be created on the 
Weigh Scale. 

 
 

Editing session files in other applications 
Spreadsheet application like Microsoft Excel can support the CSV file format. This 
means you can open, change and then re‐save session files using a spreadsheet.  

However, if you only want to make changes that can be copied back to the Weigh 
Scale, you should use the MyScale Session Editor. It is designed for that purpose. 

If you decide to make changes using another application and you want to be able 
to copy the session files back to the Weigh Scale, you need to make sure: 

 You select CSV (comma separated values) as the file format, when you save 
the file. 

 You use the correct naming convention. See Naming format for session files 
(p 19). 

 You make changes that are valid and can be copied back to the Weigh Scale.  
See Validity checks on session files (p 23). 

Note: It is recommended that you do not use Microsoft Works to edit files that 
you want to copy back to the Weigh Scale. 
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Validity checks on session files 
The MyScale Session Editor automatically performs validity checks each time you 
save changes made to a session file. 

The validation process highlights any data in the session file that cannot be 
copied back to the Weigh Scale and gives you the opportunity to change it. 

Note: If you do not change the invalid data you will not be able to save the 
session file. If you want to make changes to the file that cannot be copied back to 
the Weigh Scale, make a copy of the file, open it in another spreadsheet 
application and make the changes there. 

 

How to validate data in a session file 

You can validate a session file by: 

1. Opening the file in the MyScale Session Editor. 

2. Clicking  . 
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The validation process 

The validation process follows these steps: 

1. MyScale Pro checks the data in each cell. If it finds data that is invalid, the 
cell is highlighted and a message displays. For example, in the following 
window the Condition in Row 1 is invalid. 

 

2. To change the highlighted data, type the new data and click Replace. 

Clicking Replace changes the data and then searches for the next instance 
of invalid data in the session file. 

When all the data in the file has been checked and the invalid data replaced, 
the following screen will display. 

 

3. If you do not want to change the highlighted data, click Cancel.  Clicking 
Cancel ends the validation process. There may still be other instances of 
invalid data in your session file. 
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What changes are valid? 

If you use the MyScale Session Editor or another application to make changes to 
your session files, remember that if you want to copy these changes back to the 
Weigh Scale they must conform to the following: 

 The Electronic ID must be 15 characters or less (16 if the code has a 
leading zero). If you try to save a file that lists an invalid Electronic ID, a 
message similar to that shown below displays. 

  
 The Visual Tag Number (Tag number) must have 15 characters or less. 

You can use a "." or "/" as well as any number or letter. 

 The Weight must be a positive number less than 100,000 and with no 
more than one decimal place.  If you try to save a file that lists an invalid 
weight, a message similar to that shown below displays. 

 
 The Condition must be a 1 or 2 digit number. 

 The animal Record date is in the correct format and is within the date 
range required.   

 Each record must list a valid number in the Electronic ID column. If the 
number is either omitted or typed as all zeros, the message shown below 
displays when you try to save the file. 
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 There must be no duplicate numbers in the Electronic ID column.  If you 
try to save a file that contains duplicates of the same number, the message 
shown below displays. 

 
 The Draft Gate can be any digit 0 through 4.  If you don't assign a number, 

the Weigh Scale will interpret this gate to be its default gate. 

 The Status can be Seen, Extra or left blank.  If you try to save a file that 
contains an invalid word, a message similar to that shown below displays. 

  
If you are using an application other than the MyScale Session Editor you also 
need to note the following: 

 You must not add any new columns to the file. 

 You must not add blank rows to the file. 

Note: It is recommended that you do not use Microsoft Works to edit any session 
files that you want to copy back to the Weigh Scale. 
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Copying sessions from Weigh Scale to computer 
Use this option when: 

 You first install MyScale Pro and you want to copy all sessions from the 
Weigh Scale to the computer. 

 You have weighed animals since the last time you copied sessions to the 
computer. 

 You have accidentally deleted a session file on the computer. 

 You have made changes to a session on the Weigh Scale and you want to 
copy the changes to the session file on the computer. 

This option lets you update the session files on the computer so that they 
match the sessions on your Weigh Scale. 

Note: Do not use this option if you have made changes to session files on the 
computer and you have not yet copied the changes to the Weigh Scale.  When 
you copy sessions from the Weigh Scale to the computer, you overwrite any files 
of the same name stored on the computer.  The changes you made on the 
computer will be lost. 

 

About the MyScale folder 
The MyScale folder on your computer is where: 

 Sessions copied from the Weigh Scale to the computer are placed. 

 Session files copied from the computer to the Weigh Scale are copied from. 

 An "Email Folder" is created by default. 

 

The default location for the MyScale folder is on the desktop. 
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First time use 

The first time you select the main menu option to copy sessions from the Weigh 
Scale to the computer, MyScale Pro needs to create the folder on the computer 
that the session files are placed in. 

The following message box displays. 

 

Click OK. A folder named "MyScale" is created and placed on the desktop. 
 

Changing the location of the MyScale folder 

If you want to change the location of the MyScale folder on your computer you 
can do this using Windows Explorer. 

The next time that you use MyScale Pro and choose to copy sessions between the 
computer and the Weigh Scale, a dialog box displays indicating that MyScale Pro 
cannot find the MyScale folder in its expected location.  

 

Use this dialog box to navigate through the folders on your computer and find 
the MyScale folder in its new location. Once you have done this, MyScale Pro 
remembers the new location each time you use the program in the future.  
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Procedure ‐ Copying sessions from Weigh Scale to computer  
To copy sessions from the Weigh Scale to the computer, follow these steps. 

1. On the MyScale Pro main menu select Copy sessions from scale to 
computer. 

2. Click Next. 

The following screen displays. 

 

3. Select the required option and click Next 
 Select Copy ALL weighing sessions to computer, to copy all the 

sessions on the Weigh Scale to the MyScale folder. 

 Select Copy NEW/UPDATED weighing sessions to computer, 
to copy all sessions that are on the Weigh Scale but are not in the 
MyScale folder. The most recent session in the MyScale folder will also 
be copied from the Weigh Scale again (assuming it still exists), as it may 
have been updated since the last time you copied files to the computer. 

4. MyScale Pro checks to see whether any of the sessions copied from the 
Weigh Scale would overwrite the same session, already stored in the 
MyScale folder. 

If session files in the MyScale folder will be overwritten the following 
message displays. 

 
5. If you have... 

 made changes to any of the session files listed and you do not want 

these changes overwritten, click No. The previous screen displays. 
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If you want to… Then… 

Copy the changes made to the 
session files in the MyScale folder 
to the Weigh Scale, before 
continuing. 

Click Back and select Copy session 
files from Computer  to Scale 
from the main menu. 

Make a copy of the session files 
you have changed before 
replacing them. 

Open Windows Explorer and copy the 
files from the MyScale folder to 
another location on your computer. 

 not made any changes to the files listed since they were copied from the 
Weigh Scale, or the session on the Weigh Scale has been updated since 

the last time you copied it to the computer, then click Yes. 

While the session files are copying to the Weigh Scale, a progress screen 
displays. 

When the download is complete the total number of weight records copied 
and the number of session files created in the MyScale folder displays. 

 
6. If you want to open session files now, in the MyScale Session Editor, make 

sure the box is checked before clicking Finish. 

 
7. See Opening session files in MyScale Session Editor (p 16). 
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Replacing session files that are open 
It is possible to copy a session from the Weigh Scale to the computer, when the 
session file is already open in the MyScale Session Editor. 

If this occurs, you will have two copies of the session file: 

 The session file that is open in the session editor (and that you may have 
made changes to). 

 The session file copied from the Weigh Scale to the MyScale folder. 

When you return to the Editor, the following message box displays. 

 

 Click Yes to replace the session file that is open in the Editor with the latest 
copy from the Weigh Scale. This means any changes made to the session file 
in the Editor will be lost. 

 Click No to retain the copy of the session file that is open in the editor. If 
you then save the session file to the MyScale folder it will replace the latest 
copy from the Weigh Scale. Alternatively, you can save the file that is open in 
the session editor to another location (i.e. a location other than the MyScale 
folder) to retain both copies. 
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Transferring sessions from SmartReader to computer 
Before you begin 

 Connect the SmartReader to the computer. See Connecting the computer to 
the SmartReader. 

Note: Sessions can only be transferred into MyScale Pro if the SmartReader was 
operated in Memory Mode. 

Note: Once the sessions have been successfully transferred to the computer 
they are deleted from the SmartReader. If the connection between the 
SmartReader and the computer is broken during the transfer process, only 
completely transferred sessions are displayed.  You will need to reconnect the 
cable and restart the transfer process. 

1. On the MyScale Pro main menu select Transfer sessions from reader 
to computer.  

2. Click Next.  MyScale Pro attempts to communicate with the SmartReader. 

3. Did MyScale Pro connect to the SmartReader? If MyScale Pro has not 
connected to the SmartReader, MyScale Pro informs you of the connection 
problem. See SmartReader connection status (p 8). If MyScale Pro has 
connected to the SmartReader, one of the following will occur: 

 If a language has not yet been configured for the SmartReader, the 
following screen displays. 

 

Select a language for the SmartReader then click Apply. The transfer of 
sessions begins immediately. 

Note: The language selected in this field, updates the language used on 
the SmartReader. 

 If a language has been configured for the SmartReader, the transfer of 
sessions begins immediately. 

Note: If there are no sessions to transfer a message is displayed.  To return 

to the main menu click Back. 



3E2398  MyScale Pro W610 User Manual   

 

  Page 33 

 

4. Once the transfer is finished, click Next to review the session file names. 

 
This screen displays the sessions transferred from the SmartReader to the 
computer. 

5. The following options are now available to the user: 

 Accept the automatically generated session file names. 

 Change the automatically generated session file names. 

To accept the generated session file name: 

 Click Finish. The displayed session file names are accepted and saved on 
your computer in the Reader sub‐folder under the MyScale folder.  The 
main menu displays. 

To change the generated session file names 

 Click Explorer. A Windows Explorer window opens listing all sessions in 
the Reader folder. Change the individual file names, as required, using 
the normal Windows methods. 
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Restoring a SmartReader backup file 
Session files transferred from the SmartReader to the computer are deleted from 
the SmartReader memory. A backup file is automatically created at the time of 
downloading into MyScale Pro. If you want to replace a SmartReader session file 
in MyScale Pro with the backup file (file originally transferred), you will need to 
restore the backup file. 

Note: Restoring a SmartReader backup file (with the same name in MyScale Pro) 
will replace the file in MyScale Pro. 

To restore a SmartReader backup file: 

1. Open MyScale Pro Session Editor. Ensure all open files are closed in the 
Session Editor. 

2. Click File > Restore backup. A list of all files in the backup folder 
displays. 

3. Select the file(s) you want to restore. To select multiple files press the 'Ctrl' 
key and click each file name. 

4. Click Open. The restored file(s) are saved to the Reader sub‐folder in the 
MyScale Pro folder on the desktop.  

If the file(s) being restored are about to overwrite an existing file(s) of the 
same name in the MyScale Pro folder then a message displays. 

 To overwrite an existing file(s), click Yes or Yes To All. 
 To not overwrite an existing file, click No. 
 To save the backup file(s) as a new file in MyScale Pro, click Save As 

and enter a new file name. 

 To cancel the restore procedure, click Cancel. 

5. The following screen displays. 

 
6. To open the restored files, check the 'Open file(s) once copied' tickbox.  

7. Click OK. If the checkbox above has been checked, the restored files are 
displayed in the Session Editor. 
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Copying session files from computer to Weigh Scale 
You need to copy session files to the Weigh Scale when you have: 

 Updated one or more session files on the computer and you want to send 
the changes to the Weigh Scale. 

 Deleted a session on the Weigh Scale and you want to restore it from the 
computer. 

 

Before you begin copying session to the Weigh Scale 
Before you copy files to the Weigh Scale you should check the following: 

  Check... If you need more help, see... 

1  There is a valid connection 
between the computer and the 
Weigh Scale. 

Connecting the computer to the Weigh 
Scale (p 6) 

2  If you have moved the MyScale 
folder you know its new location. 
There are CSV files in the folder. 

About the MyScale folder (p 27) 

3  You know the names of the session 
files you have updated and want to 
copy back to the Weigh Scale. 

 

4  The session files have the correct 
naming format. 

Naming format for session files (p 19) 

5  The content of the session files is 
valid and can be copied back to the 
Weigh Scale. 

Validity checks on session files (p 23). If 
you only use the MyScale Session 
Editor to view and edit your session 
files, this item is automatically 
managed for you. 

6  The version of software on the 
Weigh Scale is compatible with the 
version of MyScale Pro you are 
using. 
This is only a possible problem if 
you installed a version of MyScale 
Pro that was not supplied with the 
Weigh Scale you are using.  

Compatibility between MyScale Pro 
and the Weigh Scale (p 36) 
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Cross reference table 
A session file may contain records that list Electronic IDs linked with Visual Tag 
Numbers.  After you copy session files to the Weigh Scale, the Weigh Scale stores 
these links if it doesn't already know about them. 

For more information about links between Electronic IDs and Visual Tag 
Numbers, see Updating the Weigh Scale's Cross Reference Table (p 59). 

 

Compatibility between MyScale Pro and the Weigh Scale 
Each time you purchase new devices (Weigh Scale, DairyScale or SmartReader) 
you must: 

 uninstall any old version(s) of MyScale Pro, and  

 install the MyScale Pro software supplied with the product. 

The new MyScale Pro software is compatible with old devices.   

Once the old devices are connected to MyScale Pro, the relevant options will 
display on the main menu and in the MyScale Session Editor.  This will mean that 
some displayed options will not be applicable to all devices.  A message box 
displays if you select an option not applicable to the connected device. 

Notes: 

 On the Weigh Scale, the version number is displayed for a few moments 

after you turn the mode select switch to S (Setup). 
 MyScale Pro supports only the comma‐separated values (CSV) file format. If 

you have copied sessions from the Weigh Scale using a version of MyScale 
Pro and changed to a format other than CSV, you will not be able to copy 
these sessions back to the Weigh Scale using MyScale Pro. If this occurs, 
copy the sessions from the Weigh Scale again, using MyScale Pro. 
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Procedure ‐ Copying session files from computer to Weigh Scale 
To copy session files from the computer to the Weigh Scale: 

1. On the MyScale Pro main menu select Copy session files from 
computer to scale.  

2. Click Next. 

The following window displays. 

 
 

If you want to… Then… 

Select the files in the 
MyScale folder to be 
copied to the Weigh 
Scale. 

Select Copy SELECTED session files to Weigh 
Scale. 

 

A pane displays listing each of the CSV files in your MyScale 
folder. Hold down the control key and click on each file that 

you want to include. Click Next. 

Note: To refresh the list press F5 or right‐click and select 
Refresh. 

Copy all session files 
in the MyScale folder 
to the Weigh Scale. 

Ensure Copy ALL session files to Weigh Scale is 
selected and click Next. 
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3. MyScale Pro checks to see if any of the files you have selected will replace a 
session currently stored on your Weigh Scale. 

If sessions on the Weigh Scale will be replaced, the following message 
displays. 

 
 Click Yes to continue. 
 Click No to cancel and return to the previous screen. 

4. The following window displays showing progress as the session files are 
copied to the Weigh Scale. 

When the transfer is complete the number of session files copied to the 
Weigh Scale and the total number of records in those session files will be 
displayed. 

 

5. Click Finish to return to the main menu. 
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When files cannot be copied to the Weigh Scale 
There are several reasons why MyScale Pro may be unable to copy a session file 
on the computer back to the Weigh Scale. 

If this occurs, you should check the following: 

Possible Cause Action Required 

The session file name does not have 
the correct format. 

See Naming format for session files (p 
19) and then use Windows Explorer to 
change file names that are not correct. 

You have edited the session file and 
added information that cannot be 
copied to the Weigh Scale, or 
removed information that MyScale 
Pro expects to find. 

See Validity checks on session files (p 
23) for a description of the format and 
type of data that MyScale Pro expects 
to find in a session file. 
Open the file in the MyScale Session 
Editor and validate the file contents. 

You have opened the file in another 
application (for example, Microsoft 
Works or Microsoft Excel) and then 
saved it using a format other than 
comma separated values (CSV). 

Open and then save the file in the 
application you used, making sure that 
you select CSV as the file format. 
Open the CSV file in the MyScale 
Session Editor and validate the file 
contents. See Validity checks on session 
files (p 23). 

The file is currently open in an 
application other than the MyScale 
Session Editor (e.g. Microsoft Excel). 

Close the session file. 
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Session file fields 
The following is a list of fields that may appear in a session file.  What field 
displays depends on the session type and the set up of the Weigh Scale. 

Field Description 

Electronic ID  Electronic ID as entered via the Weigh Scale or Tag bucket 
file.  See Copying Records from a Tag Bucket File (p 64). 

Tag number  Visual Tag Number as entered manually via the Weigh 
Scale or via MyScale Pro. 

Weight  Weight as recorded on the Weigh Scale. 

Conditions  Condition score as entered on the Weigh Scale. 

Date  Date the record was created.  If the record date was not 
captured the screen date is displayed. 

Draft gate  Draft gate assigned to the animal on the Weigh Scale 
during Drafting. 

Applicable to Draft sessions only. 

Status  Applicable to Draft list sessions that have been processed 
on the Weigh Scale and transferred back to the computer.  

This column indicates whether the listed animal was: 

‐ Seen during the session 
‐ Extra to the Draft list 
‐ <blank> as not processed during the session. 

Applicable to Draft by List sessions only.  See 
Understanding a Draft list. 

Draft limits  The Draft limits as originally set in MyScale Pro.  If the 
Draft limits are changed on the Weigh Scale they are not 
copied back to MyScale Pro. 

Applicable to Draft by List sessions only. 

Herd  Lists the name of the herd in which the animal listed. 

Applicable to DairyScale only. 

Cause  Description of the alarm. 

Applicable to DairyScale only. 

Weight loss  The amount of weight loss over the previous seven days. 

Applicable to DairyScale only. 

PIN  Property Identification Number as entered when the 
session was created on the Weigh Scale.  Must be 
identical for all records in the session. 

Applicable to W610 Weigh Scale USA sites only. 
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MYSCALE SESSION EDITOR 
MyScale Pro has a built‐in Session Editor that lets you edit files uploaded from 
your Weigh Scale.  

The MyScale Session Editor operates like most other spreadsheet applications 
but has added options that let you work specifically with session files. 

You can use the MyScale Session Editor to work with session files in the following 
ways: 

What you can do… For more information, refer 
to… 

Opening, saving and closing one or 
more session or graph windows. 

File menu (p 43) 

Selecting, overwriting, copying, pasting 
or deleting records within a session. 

Edit menu (p 46) 

Arranging the open session files within 
the session editor window. 

Window menu (p 51) 

Changing focus from one window to 
another. 

Window menu (p 51) 

Adding or deleting records.  Tools menu (p 47) 

Copying and pasting information from 
another application. 

Edit menu (p 46) 

Sorting records.  Tools menu (p 47) 

Searching for text.  Tools menu (p 47) 

Undoing the last editing action.  Edit menu (p 46) 

Creating an animal weight gain graph.  Tools menu (p 47) 

Generating session statistics.  Tools menu (p 47) 

Printing all or selected records, graphs 
or statistics. 

File menu (p 43) 

Validating changes to ensure they can 
be copied back to the Weigh Scale. 

Tools menu (p 47) 

Email session records  Emailing session records (p 109) 
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MyScale Session Editor overview 
Components of the MyScale Session Editor window are shown below. 

 

Session information is displayed in a spreadsheet containing rows and columns. 

Each row is numbered. Within the session editor, a row is referred to as a record. 

The intersection of each row and column on the spreadsheet is referred to as a 
cell. Each item of information on the spreadsheet is contained within a cell. 

In most cases, the MyScale Session Editor works like most spreadsheet 
applications. Some exceptions are evident. For example, you cannot select 
individual cells by use of the Ctrl + Click command. 
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File menu 
Click File in the MyScale Session Editor to display the drop‐down File menu. 

Options available on the File menu are listed below. 

New 
Creates a new, empty session window. 

Open 
Opens a standard session, report, or graph in MyScale Session Editor. 

Placing the cursor over the Open extends the other options, clicking on one 
option... 

 

... will display all the relevant lists or session files in your MyScale folder. To open 

a file, click on the file name and click Open. 

Open Graph 
Opens a graph in the MyScale Session Editor. 

All the graph files in your MyScale > Graphs  folder will be listed. To open a 
graph file, click on the file name and click Open.For more information see 
Opening session files in MyScale Session Editor (p 16). 

Open Report 
Opens a previously saved report.  See Opening a report (p 53). 

Close 
Closes the standard session, or graph. 

If you have made changes that have not been saved you will be asked if you want 
to save before closing. 

Save 
Saves the current session, or graph. 

Any changes you have made are saved back to the MyScale folder. 
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Save As 
Saves the current session or graph using a new file name or location on the 
computer. 

If the session or graph already has a file name, the name and folder will be 

displayed. You can change either of these before clicking Save. 

Email Session... 
Sends the currently open session to a user‐defined email address.  See Emailing 
session files (p 109). 

Restore Backup 
Restores a SmartReader backup file. 

See Restoring a SmartReader backup file for more information. 

Print 
Prints the contents of the current selection. 

The current selection can be: 

 a session file, 

 a group of cells within a session file, 

 a report, 

 a graph, or 

 statistics. 

A print dialog box displays. You can select the printer and any other print settings 
you require (these depend on the printer you are using). A Print Preview screen 
then displays. To confirm that you want to print the information, click the printer 
icon in the Print Preview screen. See Print preview (p 44) for more information. 

Note: Do not use the Microsoft Office Document Image Writer printer driver with 
MyScale Pro. 

Exit 
Closes any open windows and then closes the MyScale Session Editor.  

The MyScale Pro main menu displays. 

 
 

Print preview 
The Print Preview screen lets you confirm the information to be printed 
before sending it to the printer. It is the final step after confirming the print job. 

There are options you can use to change the magnification and to display each 
page in a multiple page document. You can also save the document for printing 
later. 
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The icons in the Print Preview screen are described in the following diagram. 

 

Note: Do not use the Microsoft Office Document Image Writer printer driver with 
MyScale Pro. 
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Edit menu 
Click Edit in the MyScale Session Editor to display the drop‐down Edit menu. 

The options on the Edit menu let you work with and make changes to records in a 
session file or draft list. 

The following describes the options available on the Edit menu. 

Undo 
Undoes the last editing action. 

For example, after pasting text into a cell, selecting Undo removes the pasted 
text. 

Cut 
Removes the selected text and places it on the clipboard. 

Copy 
Makes a copy of the selected text and places it on the clipboard. 

Paste 
Pastes the contents of the clipboard into the window at the current cursor 
location. 

If you are pasting data from another application, you must use the copy 
command in the other application to copy the data to the clipboard. Use the 
paste command in the MyScale Session Editor to paste the information from the 
clipboard into the window. 

Clear 
Deletes the selected text. 

Select All 
Selects all cells in the window. 

Find 
Lets you search for particular text within the currently selected file. 

Enter the text that you want to search for in the Find dialog box and click Find 
Next. MyScale Pro searches for and highlights the first instance of the text in the 

window. Click Find Next to search for the next occurrence of the text. When 
MyScale Pro has searched the entire window and there are no further 
occurrences of the text a Search string … … not found message displays. 

Find Next 
Searches from the current cursor location for the next occurrence of the text 
entered in the Find dialog box (see above).  

Find Next functionality can be accessed from either the Find dialog box or this 
edit menu option. 
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Right mouse-click menu 
In addition to the main Edit menu, a right mouse‐click whilst in an open session in 
the MyScale Session Editor displays the following menu: 

 

Fill down option 
If you use the mouse to highlight all or part of a column in which you wish to copy 
the first value to all other cells, right click in that cell. 

 

When the menu displays, left click on Fill Down and the value is copied into all 
the highlighted cells. 

 
 

Tools menu 
Click Tools in the MyScale Session Editor to display the drop‐down Tools menu. 

Options available on the Tools menu are listed below. 

New Record 
Inserts a new record in the session or draft list window, immediately above the 
currently selected row. 

Delete Record 
Deletes the currently selected record. 
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Import Tag Bucket File 
This option only displays when updating the cross‐reference table.  See Copying 
Records from a Tag Bucket File (p 64). 

Validate 
Validates the contents of the current session or draft list window. 

Validation ensures the file can be copied back to the Weigh Scale.  

See Validity checks on session files (p 23) for more information. 

Sort Ascending 
For the active session or draft list window, sorts records from the lowest to the 
highest (A to Z), based on the contents of the currently‐selected column. 

Sort Descending 
For the active session or draft list window, sorts records from the highest to the 
lowest (Z to A), based on the contents of the currently‐selected column. 

Show Statistics 
For the active session or draft list window, generates statistics of all records or 
the currently‐selected block of records. 

See Session statistics (p 103) for more information. 

Create Graph 
Creates a weight gain graph for the currently selected animal. If more than one 
animal is selected, creates a graph of average weight for all open sessions. 

To create the graph, MyScale Pro uses information from any windows that 
contain a weight record for the animal. See Creating a weight gain graph (p 106) 
for more information. 

Weight Units 
For the active session or draft list window, lets you select the unit of weight. 

You can select lb or kg.  

The weight unit is displayed when MyScale Pro creates an animal weight gain 
graph. 
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Change scale setup 
Enables you to alter the Weigh Scale configuration options.  Select the required 

radio buttons and press Next. 

 

You need to be connected to the Weigh Scale so that: 

 the current setting can be read and displayed, and  

 the new settings can be sent to the Weigh Scale. 

Change EID Setup 
Enables you to change the way Electronic ID tags are downloaded.  

Current options:  

None - Rest of World 

France - changes the leading characters to numeric.  "A" is changed to 
"1", "R" or is changed to "0". 

 

Change Scale setup 
Enables you to alter the Weigh Scale configuration options.  Select the required 

radio buttons and press Next. 

 

You need to be connected to the Weigh Scale so that: 

 the current setting can be read and displayed, and  

 the new settings can be sent to the Weigh Scale. 
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Change EID Setup 
Enables you to change the way Electronic ID tags are downloaded.  

Current options:  

None - Rest of World 

France - changes the leading characters to numeric.  "A" is changed to 
"1", "R" or is changed to "0". 

 

Reports menu 
The following reports can be generated for one or more selected animals: 

 Target Weight Report 

 Target Date Report 

 Animal Weight report 

For more details on these reports, see Generating reports (p 53). 

Note: If you want to open report files in Excel (or similar) you need to rename the 

file with a .CSV extension. 
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Window menu 
Click Window in the MyScale Session Editor to display the drop‐down Window 
menu. 

Cascade 
Arranges the open files in a cascade. 

This lets you see the name of each session file. You can click on any visible 
portion of any file to move the focus to that file. 

 

Tile Horizontally 
Arranges the open files one beneath the other. Each file displays across the full 
width of the MyScale Session Editor window. 

You can use the vertical scroll bar to scroll up or down to view all open files. You 
can click on any visible portion of any file to move the focus to that file. 

 

Tile Vertically 
Arranges the open files one beside the next from left to right. Each file occupies a 
vertical band within the MyScale Session Editor window. 
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You can use the horizontal scroll bar to scroll left and right to view all open files. 
You can click on any visible portion of any file to move the focus to that file. 

 

List of file names 
Lists all files that are open in the MyScale Session Editor.  

Click on any file name or type its number to move the focus to that file. 

A tick displays next to the file with the current focus. 
 

Help menu 
As you use MyScale Pro, online help is available.  The online help contains the 
same information as the user manual. 

Accessing Help 

You can access the online help in any of the following ways: 

 Press F1. 
 In MyScale Pro's initial window, click on Help. 
 On the MyScale Session Editor menu bar, click on Help and then MyScale 

Help. 

 
Using the online help  

The online help displays in your default internet browser.  Your need to select the 
appropriate manual to use the device (Weigh Scale or Electronic Controller) you 
are connecting to the computer. 
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GENERATING REPORTS 
Reports are sorted by Electronic ID (if there is one) or by Visual Tag Number.   

Note: If a Visual Tag Number is contained in multiple records, some with an 
associated Electronic ID and some without the Electronic ID, the records without 
the Electronic ID will be ignored when generating reports. 

 

Average Daily Gain calculation 
The Average Daily Gain is calculated using the following: 

   

(Most recent weight for the animal) ‐ (Animal's next most recent weight) 

(Number of days between the two weight measurements) 

 

The weights are located by searching through all session files in the MyScale 
folder, starting with the most recent, until two weights on different dates are 
found for each animal. 

 

Saving a report 
To save a generated report: 

1. Select File > Save. 

The Save dialog box displays. 

2. Click Save. 

Keep the system generated file name and location so the system recognises 
the file as a report when you open the report at a later date. 

Reports are saved into the MyScale > Reports folder as an ".msr" file. To 
open the file in Microsoft Excel (or similar), rename as a ".csv" file. 

 

Opening a report 
To open a previously saved report: 

1. Select File > Open > Open Report. 

The Open dialog box displays 

2. Select the report you want to view and click Open. 

The selected report opens and can be viewed and printed. 
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Printing a report 
To print a open report: 

1. Select File > Print. 

The standard print dialog box displays. 

2. Click OK. 

The Print preview screen displays.  See Print preview (p 44). 

3. Review the displayed information. 

4. To print the displayed report, click  . 

To close the report window, click Close. 
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Target Date Report 
This report provides an estimated weight for the selected animals at a specified 
date. 

 

Procedure ‐ Create Target Date Report 
To create a Target Date Report for a group of animals: 

1. Copy from the Weigh Scale to the computer appropriate sessions files. 

2. On the MyScale Pro main menu select Open session files in MyScale 
Editor. 

3. Select the most recent session file containing weight records for the required 

animals and click Open. 

4. Highlight the required records.  To include all records select only one record. 

5. Select Reports > Target Date Report. The following screen displays: 

 

6. Select the required Report on: option. 

7. Select the required target date and click Next. 

The Target Date Report generates and displays. 
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Target Weight Report 
This report provides an estimated date for when the selected animals will reach 
an entered target weight. 

 

Procedure ‐ Create Target Weight Report 
To create a Target weight report for a group of animals: 

1. Copy from the Weigh Scale to the computer appropriate sessions files. 

2. On the MyScale Pro main menu select Open session files in MyScale 
Editor. 

3. Select the most recent session file containing weight records for the required 

animals and click Open. 

4. Highlight the required records.  To include all records select only one record. 

5. Select Reports > Target Weight Report. The following screen 
displays: 

 
6. Select the report on animals option. 

7. Enter the required target weight and click Next. 

The Target weight report generates and displays. 
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Animal History Report 
This report provides the Average Daily Gain figure for the selected animals 
between two specified dates. 

 

Procedure ‐ Create Animal History Report 
To create an Animal History Report for a group of animals: 

1. Copy from the Weigh Scale to the computer appropriate sessions files. 

2. On the MyScale Pro main menu select Open session files in MyScale 
Editor and click Next. 

3. Select the most recent session file containing weight records for the required 

animals and click Open. 

4. Highlight the required records.  To include all records select only one record. 

5. Select Reports > Animal History Report. The following screen 
displays: 

 
6. Select the report on animals option. 

7. Select the required date range and click Next. 

The Animal History Report is produced and displays. 
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UPDATING THE WEIGH SCALE'S CROSS‐
REFERENCE TABLE 

The cross‐reference table is a list stored within the Weigh Scale's memory that 
links Electronic IDs to their associated Visual Tag Number. 

On the Weigh Scale, when you scan an Electronic ID you can, if you choose, enter 
an associated Visual Tag Number. In the future, each time you scan the Electronic 
ID, the Visual Tag Number that you entered is displayed on the Weigh Scale's 
screen. A permanent association between the Electronic ID and the Visual Tag 
Number has been made in the Weigh Scale's memory in the cross‐reference 
table. 

From MyScale Pro you can edit the cross‐reference table on the Weigh Scale and 
change or remove the Visual Tag Number associated with any Electronic ID. 

 

Who uses the Cross‐Reference table 
If you are scanning Electronic IDs when you weigh animals AND entering an 
associated Visual Tag Number, then you are using the Weigh Scale's cross‐
reference table. 

A session file may contain records that list Electronic IDs linked with Visual Tag 
Numbers.  After you copy session files to the Weigh Scale, the Weigh Scale stores 
these links if it doesn't already know about them. 

For more information about links between Electronic IDs and Visual Tag 
Numbers, see Updating the Cross Reference Table (p 59). 
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Updating the Cross‐Reference table 
To update the cross‐reference table in the Weigh Scale follow these steps. 

1. Make sure a valid connection between the Weigh Scale and the computer 
has been established. See Connecting the Computer to the Weigh Scale (p 6) 
if required. 

2. From MyScale Pro main menu select the Update cross-reference table 
in the scale option and click Next. 

The cross‐reference table is copied from the Weigh Scale to the computer 
and opens in the MyScale Session Editor. 

 
If you have a large number of records stored in the cross‐reference table this 
step may take several minutes to complete. 

3. An instruction box displays.  

Read the instructions and then click OK. 

4. Make your changes.  

   You can: 

 Add, delete or change any Tag number. 

 Delete an Electronic ID. 

 Delete a record. See Tools menu (p 47). 

 Add a record.  See Tools menu (p 47). 

 Copy and paste records from another application or from within the 
MyScale Session Editor. 

 Import records from a Tag Bucket file. See Copying Records from a Tag 
Bucket File (p 64). 

You cannot: 

 Edit an Electronic ID using the keyboard. 



   3E2398  MyScale Pro W610 User Manual 

 

Page 60 

 

This means if you add a record you must copy and paste the Electronic ID 
into the field. 

If you need more help with making changes in the MyScale Session Editor, 
see MyScale Session Editor (p 41). 

5. When you have completed your changes, click File > Close. 

The Confirm window displays. 

 
 

If you want to..... Then..... 

Save the changes you have made 
back to the cross‐reference table in 
the Weigh Scale. 

Click Yes. 

The following window displays, confirming 
when the process has completed. 

 

Click Finish. 

Close the spreadsheet and discard 
the changes you have made. 

Click No. 

Return to the cross‐reference table 
in the MyScale Session Editor, 
without saving. 

Click Cancel, continue from Step 5. 

6. If you choose to save the changes, MyScale Pro checks for the following 
conditions: 

 Records that contain no Electronic ID. These records are removed before 
copying the cross‐reference table back to the Weigh Scale. 

 Records with conflicting links. See Conflicting Electronic ID to Visual Tag 
Number Links (p 61) for more information. 

Records that contain an invalid Electronic ID or Tag number. See Validity 
Checks on Session Files (p 23) for more information. You must change the 
invalid data or remove an invalid record before the cross‐reference table can 
be copied back to the Weigh Scale. 
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Conflicting Electronic ID to Visual Tag Number links 
A conflicting link occurs when an Electronic ID number is linked to two different 
Visual Tag Numbers. 

For example, records 14 and 15 in the window below would cause a conflicting 
link. 

 

Electronic ID number 0982 536 416 551 946 is linked with Visual Tag Numbers 
B510 and B511. 
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What MyScale Pro does with conflicting Electronic ID 
to Visual Tag Number links 

When you save the changes made to the cross‐reference table in the MyScale 
Session Editor, MyScale Pro checks for conflicting links. 

If a conflict occurs, MyScale Pro asks you to indicate the correct link before the 
changes can be saved back to the Weigh Scale. 

 

For example, in the previous message: 

To… Then… 

Make visual identification tag code 419 the correct link 
and to delete the 629 link: 

Click Yes. 

Make visual identification tag code 629 the correct link 
and to delete the 419 link: 

Click No. 

To return to the cross‐reference table in the MyScale 
Session Editor make further changes. 

Click Cancel. 

 

 



3E2398  MyScale Pro W610 User Manual   

 

  Page 63 

 

ANIMAL IDENTIFICATION 

Explaining Electronic ID and Visual Tag Number Tags 
These are defined as: 

Electronic ID  Electronic ID number is the electronic code in an ear tag that 
can be scanned to recognise an individual animal. 

Visual Tag 
Numbers 

A Visual Tag Number is the combination of letters and/or 
numbers printed on the ear tag to enable visual recognition 
of an individual animal or group of animals. This can be 
augmented by other options such as the colour of the tag. 

To get a new Electronic ID Number record into the system the Electronic ID must 
be either: 

 electronically read using an Electronic ID reader (several types of Electronic 
ID readers are available). You may choose to link a Visual Tag Number of 
your choice using the Weigh Scale (see Weigh Scale W610 User Manual). 
This relationship is then retained in a table in the Weigh Scale called the 
cross‐reference table, or 

 imported via the Tag bucket file.  See Copying Records from a Tag Bucket File 
(p 64). 

 

Editing Electronic ID Numbers 
Electronic ID numbers are listed in the column headed Electronic ID.  You 
cannot edit Electronic ID numbers directly.  However you can paste text into any 
cell that has been copied to the clipboard from another application or session 
window.  Your need to edit Electronic ID numbers should be relatively infrequent. 

 

Editing Visual Tag Numbers 
Visual Tag Numbers are listed in the column headed Tag number. 

When you enter a Visual Tag Number, letters are automatically displayed and 
saved in upper case (capitals). 

Visual Tag Numbers can be up to 15 characters in length. 
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Copying Records from a Tag Bucket File 
If your Electronic ID's and associated Visual Tag Number's have been supplied in a 
Tag Bucket file, you can copy these directly to the Weigh Scale's cross‐reference 
table. In future when you scan any Electronic ID tag contained in the Tag Bucket 
file, the associated visual tag number  be displays on the Weigh Scale. 

To import a Tag Bucket file to the cross‐reference table, follow these steps: 

1. Make sure a valid connection between the Weigh Scale and the computer 
has been established. See Connecting the Computer to the Weigh Scale (p 6) 
if required. 

2. From MyScale Pro main menu select the Update cross-reference table 
in the scale option and click Next. 

An instruction box displays.  

3. Read the instructions and then click OK. 

The cross‐reference table is copied from the Weigh Scale to the computer 
and opens in the MyScale Session Editor. 

 
4. If you have a large number of records stored in the cross‐reference table this 

step may take several minutes to complete. 

5. Select Tools > Import Tag Bucket File. 
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A dialog box displays letting you locate the Tag Bucket file that you want to 
import. If you have previously located Tag Bucket files, MyScale Pro defaults 
to the folder these are stored in. Otherwise, it defaults to the MyScale 
folder. 

 

6. Select the Tag Bucket file and click Open. 

The contents of the Tag Bucket file are copied into the cross‐reference table. 
You can repeat this procedure from Step 6 if you have other Tag Bucket files 
to import. 

7. Make your changes.  

   You can: 

 Add, delete or change any Tag number. 

 Delete an Electronic ID. 

 Delete a record. See Tools menu (p 47). 

 Add a record.  See Tools menu (p 47). 

 Copy and paste records from another application or from within the 
MyScale Session Editor. 

 Import records from a Tag Bucket file. See Copying Records from a Tag 
Bucket File (p 64). 

You cannot: 

 Edit an Electronic ID using the keyboard. 

This means if you add a record you must copy and paste the Electronic ID 
into the field. 

If you need more help with making changes in the MyScale Session Editor, 
see MyScale Session Editor (p 41). 

8. When you have completed your changes, click File > Close. 

The Confirm window displays. 
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If you want to..... Then..... 

Save the changes you have made 
back to the cross‐reference table in 
the Weigh Scale. 

Click Yes. 

The following window displays, confirming 
when the process has completed. 

 

Click Finish. 

Close the spreadsheet and discard 
the changes you have made. 

Click No. 

Return to the cross‐reference table 
in the MyScale Session Editor, 
without saving. 

Click Cancel, continue from Step 5. 

9. If you choose to save the changes, MyScale Pro checks for the following 
conditions: 

 Records that contain no Electronic ID. These records are removed before 
copying the cross‐reference table back to the Weigh Scale. 

 Records with conflicting links. See Conflicting Electronic ID to Visual Tag 
Number Links (p 61) for more information. 

 Records that contain an invalid Electronic ID or Tag number. See Validity 
Checks on Session Files (p 23) for more information. You must change the 
invalid data or remove an invalid record before the cross‐reference table 
can be copied back to the Weigh Scale. 
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CREATING AN NLIS TRANSACTION FILE 
What It Is 

NLIS stands for National Livestock Identification System. The MyScale NLIS Utility 
is a simple alternative to the NLISLink program. The MyScale NLIS Utility 
generates a transaction file that contains information about changes in livestock 
ownership and location. These files are used in the same way as those created by 
the NLISLink program.  

Note:  The NLIS application is only available to the Australian market. 

When to use 
You can create an NLIS transaction file using MyScale Pro if : 

 You take part in the NLIS program. 

 You have sold or transferred livestock from your farm, and, 

 You have transferred session files from your SmartReader to your computer 
that contain Electronic ID records for these animals. 

 

Procedure ‐ Create NLIS file 
To create an NLIS transaction file, follow these steps: 

1. Select Create NLIS file on the MyScale Pro main menu and then click 

Next.  

The following screen displays. 

 
 To open the MyScale Pro Online Help for the NLIS Utility, click Help. 
 To close the NLIS Utility without creating an NLIS file, click Back. 

2. Click on the session containing the animals to be sold or transferred to 
another property. 

Note: If no sessions are displayed, you will need to connect to the Weigh 
Scale and copy sessions to the computer. See Copying Sessions to the 
Computer (p 27). 

If the animals are not contained within one session you can open multiple 
session files. To open multiple files hold down the Ctrl key and click on each 
session file name.  
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3. Click Next. 

The following screen displays. 

 
 

If you want to..... Then select..... 

Display the visual tag numbers stored in the 
session files. 

 

Display the visual tag numbers stored in Tag 
Bucket files. 

 

4. Select Load from Session files or Use Tag Bucket files. 

 If you selected  , refer to Using Tag Bucket files (p 91). 

5. Click Next. 

A dialog box similar to the following displays.  If some of the session file 
records do not be displayed it is because they have duplicate Electronic IDs 
or no Electronic ID. 

 

6. Click OK to continue.  The following screen displays. 
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Note: Only records containing Electronic IDs will be shown.  Duplicate 
records (i.e another weight record for the same animal contained in a 
different session file) will not be displayed. 

7. Click on the check box to the left of each animal to be transferred.  

 To transfer all the animals, click Select All. 

8. Click Next.  A confirmation screen displays. 

 

9. If the correct animals are displayed, click Next. 
 If the selection is incorrect click Back to return to the previous screen 

and change your selection. 

When you have confirmed your selection, the Transaction details screen 
displays. If you have used this program before you can double click on any 
text box to fill in the values you entered last time. 

 
You must enter the following information: 

 Seller PIC (your own property identification code). This must be a 
minimum of 8 characters. 

 Buyer PIC (the buyer's property identification code). This must be a 
minimum of 8 characters. 

 EUVD / NVD (EU Vendor Declaration/ National Vendor Declaration) The 
first character can be a letter or digit followed by unlimited digits. If your 
NVD is loose leaf and does not have a number stamped on it, the number 
12345678 should be used or leave the field blank. 

 Your Phone No, including area code. This field is optional. You can enter 
up to 12 digits: no spaces, dashes or brackets. 
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 Sale Date. Today's date will display. To select a different date, click on 
the triangle next to the date and select the sale date from the calendar 
that displays. Click the right or left arrow buttons to change the month. 
Click on the day to select it. 

 
Note: You cannot select a future date. 

10. If the transaction is being entered on behalf of a third party, check the 3rd 
Party Transfer checkbox and click Next.  

The Authorisation Details dialog box is displayed. Enter the name of the 
person who authorised this transfer, in the First Name and Last Name boxes, 
then select the appropriate Authorisation Level from the drop down menu. 
Read the disclaimer then check the I accept the above disclaimer checkbox. 

11. If you want to open your web browser and display the NLIS web page check 
the Launch Web Browser checkbox.  The file created for this transaction can 
be sent to NLIS by logging on to the site from this web page. 

12. Click Finish.  

A text file for this transaction is created and placed in a NLIS Transaction 
Files sub folder of the MyScale folder. The name of the file is the unique 
vendor declaration number (EU Vendor Number), followed by the sale date, 
current time and phone number of the seller for the particular transaction. 

A screen, similar to the one below will confirm the name and location of the 
NLIS transaction file. 

 
13. Check Copy the path to the clipboard for me if you want to copy the path to 

your NLIS transaction file to the clipboard. This lets you use the paste 
command (Ctrl+V) in your web browser to copy the path to the text box on 
the NLIS website page where you select the transaction file to upload. 

The option you select (checked or unchecked) will display again the next 
time you use the NLIS Utility. 

Note: If you use the copy command again in this or any other application the 
contents of the clipboard will be overwritten.  

14. Click OK. 
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If you chose to open the NLIS web page (i.e. Launch Web Browser was 
checked in the Transaction details screen) your web browser opens and 
displays the NLIS web page (www.nlis.mla.com.au). Follow the instructions 
provided by NLIS to logon to the site and upload your transaction file. 

Notes: 

For deceased cattle: Enter DECEASED in the Buyer PIC box. 

If selling outside of the EU and PIC of purchaser is unknown: Enter 
AAAAAAAA (Every effort must be made to identify the purchaser, before 
using this option). 

For transfer with an unknown national vendor declaration number (NVD), if 
your NVD is loose leaf and does not have a number stamped on it: Enter 
12345678 in the EUVD/ NVD box. 
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Sending the NLIS Transaction File 
To send the NLIS transaction file, you can do either of the following: 

 Copy the file to a cd and post to: 

Database Administrator,  

Level 1, 165 Walker St  

NORTH SYDNEY. NSW 2060 

 Access the NLIS Web Page (www.nlis.mla.com.au) with your NLIS provided 
password, and follow instructions from there to upload the file directly onto 
the NLIS Database Website. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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USING CCIA TRANSACTION FILES 
The Canadian Livestock Tracking System (CLTS) is run by the Canadian Cattle 
Identification Agency (CCIA) to track the movement of cattle into, out of, and 
throughout Canada. If you take part in the CCIA scheme you are required to 
report changes in animal ownership and location to the CCIA authorities. This 
information can be reported by uploading a file (CCIA transaction file) directly 
from MyScale Pro to the CCIA website. You can specify the animals you want to 
include in the file.   

You can create a CCIA transaction file, if: 

 you are a registered member of the CCIA program 

 you have bought, sold or moved livestock to or from your farm 

 you have set the country code in MyScale Pro to USA/Canada or French 
Canada 

 

CCIA transaction file types 
Types of CCIA transaction files you can create are: 

CCIA transaction file type Used to indicate... 

Animal Birthdate   the actual birth date or first day of calving 
applied to single tag or a tag range of animals 

Animal Exported  if animals have been moved outside the 
Canadian border 

Animal Imported  if animals have been brought from outside the 
Canadian border into Canada 

Move into Inventory  if animals have been moved into your inventory 
from the inventory of another party 

Move out of Inventory  any animals that have been moved out of your 
inventory into the inventory of another party 

Animal Retired or Slaughtered  any animals that have been slaughtered or died 
within the Canadian borders ‐ to be reported at 
point of slaughter 

Animal Sighted  an arbitrary sighting of a CCIA tag number on an 
animal 
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Creating a CCIA transaction file 
To create a CCIA transaction file, follow these steps: 

1. From the MyScale Pro main menu, select Create CCIA file and click 
Next.  

The following screen displays. 

 
 To open the MyScale Pro Online Help for the CCIA Utility, click Help. 
 To close the CCIA Utility without creating a CCIA file, click Back. 

2. Click on the session containing the animals to be sold or transferred to 
another party. 

Note: If no sessions are displayed, you will need to connect to the Weigh 
Scale and copy sessions to the computer. Refer to Copying Sessions to the 
Computer (p 27). 

If the animals are not contained within one session you can open multiple 
session files. To open multiple files hold down the Ctrl key and click on each 
session file name.  

3. Click Next. 

The following screen displays. 
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If you want to..... Then select..... 

Display the visual tag numbers stored in the 
session files. 

 

Display the visual tag numbers stored in Tag 
Bucket files. 

 

4. Select Load from Session files or Use Tag Bucket files. 

 If you selected  , refer to Using Tag Bucket files (p 91). 

5. Click Next. 

A dialog box similar to the following displays.  If some of the session file 
records are not displayed, it is because they have duplicate Electronic IDs or 
no Electronic ID. 

 

6. Click OK to continue.  The following screen displays. 

 
Note: Only records containing Electronic IDs will be shown.  Duplicate 
records (i.e another weight record for the same animal contained in a 
different session file) will not be displayed. 

7. Click on the check box to the left of each animal to be included in the CCIA 
file.  

 To select all the animals, click Select All. 
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8. Click Next.  A confirmation screen displays. 

 

9. If the correct animals are displayed, click Next.   If the selection is incorrect 
click Back to return to the previous screen and change your selection.  The 
following screen displays: 

 
This screen enables you to specify the CCIA transaction file type that you are 
about to create. 

10. Select the type of transaction file you require and click Next. 

Refer to one of the topics below on how to create and send your chosen 
CCIA transaction file type. 

 

What happens next 
Refer to one of the topics below on how to create and send your chosen CCIA 
transaction file type. 

 Creating a CCIA 'Birthdate' file (p 77) 

 Creating a CCIA 'Export' file (p 78) 

 Creating a CCIA 'Import' file (p 78) 

 Creating a CCIA "Move into Inventory' file (p 80) 

 Creating a CCIA 'Move out of Inventory' file (p 81) 

 Creating a CCIA 'Retired/ Slaughtered' file (p 82) 

 Creating a CCIA 'Sighted' file (p 83) 
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Creating a CCIA 'Birthdate' file 
Follow these steps to create a CCIA 'Birthdate' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter your Source Account code (maximum 20 characters, numeric or 
uppercase). This code is retained in this field once it has been entered for 
the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. If the Date of Birth displays as blank, click the drop down arrow and 
select the birth‐date. 

Note: This field defaults to the current date. If one animal is selected, the 
birth‐date of that animal can be entered, for a group of animals, enter a date 
at the beginning of the calving season. You cannot enter a date greater than 
the current date. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Export' file 
Follow these steps to create a CCIA 'Export' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter your Source Account code (maximum 20 characters, numeric or 
uppercase). This code is retained in this field once it has been entered for 
the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. Click the Date of Export drop down arrow to select the date of export, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS wesite on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed. 

The check box Copy the path to the clipboard for me is checked by 
default. This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Import' file 
Follow these steps to create a CCIA 'Import' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Destination Account code of where the animals are being 
imported to (maximum 20 characters, numeric or uppercase). This code is 
retained in this field once it has been entered for the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. Click the Date of Import drop down arrow to select the date of import, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS wesite on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed. 

The check box Copy the path to the clipboard for me is checked by 
default. This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Moved into Inventory' file 
Follow these steps to create a CCIA 'Moved into Inventory' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Destination Account and Destination Premises of the 
animals destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this data. 

3. Click the Date of Moving drop down arrow to select the date of 
movement, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Moved out of Inventory' file 
Follow these steps to create a CCIA 'Moved out of Inventory' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account and Source Premises of the animals 
destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

3. The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this data. 

4. Click the Date of Moving drop down arrow to select the date of 
movement, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

5. Enter optional information in the Comment field. 

6. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

7. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

8. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 

 



   3E2398  MyScale Pro W610 User Manual 

 

Page 82 

 

Creating a CCIA 'Retired / Slaughtered' file 
Follow these steps to create a CCIA 'Retired / Slaughtered' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account code for where the animals are being retired 
(maximum 20 characters, numeric or uppercase).  

Notes:  

The data is retained in this field once it has been entered for the first time. 
The CCIA issue an Account ID to each registered user. You will need to be a 
registered member of the CCIA to receive this code. 

3. Click the Date Retired drop down arrow to select the date of movement, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Sighted' file 
Follow these steps to create a CCIA 'Sighted' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account and Source Premise of the animals 
destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this code. 

3. Click the Date of Sighting drop down arrow to select the date of the 
sighting, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Birthdate' file 
Follow these steps to create a CCIA 'Birthdate' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter your Source Account code (maximum 20 characters, numeric or 
uppercase). This code is retained in this field once it has been entered for 
the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. If the Date of Birth displays as blank, click the drop down arrow and 
select the birth‐date. 

Note: This field defaults to the current date. If one animal is selected, the 
birth‐date of that animal can be entered, for a group of animals, enter a date 
at the beginning of the calving season. You cannot enter a date greater than 
the current date. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Export' file 
Follow these steps to create a CCIA 'Export' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter your Source Account code (maximum 20 characters, numeric or 
uppercase). This code is retained in this field once it has been entered for 
the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. Click the Date of Export drop down arrow to select the date of export, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS wesite on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed. 

The check box Copy the path to the clipboard for me is checked by 
default. This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Import' file 
Follow these steps to create a CCIA 'Import' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Destination Account code of where the animals are being 
imported to (maximum 20 characters, numeric or uppercase). This code is 
retained in this field once it has been entered for the first time. 

Note: The CCIA issue an Account ID to each registered user. You will need to 
be a registered member of the CCIA before entering this data. 

3. Click the Date of Import drop down arrow to select the date of import, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS wesite on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed. 

The check box Copy the path to the clipboard for me is checked by 
default. This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Moved into Inventory' file 
Follow these steps to create a CCIA 'Moved into Inventory' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Destination Account and Destination Premises of the 
animals destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this data. 

3. Click the Date of Moving drop down arrow to select the date of 
movement, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Moved out of Inventory' file 
Follow these steps to create a CCIA 'Moved out of Inventory' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account and Source Premises of the animals 
destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

3. The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this data. 

4. Click the Date of Moving drop down arrow to select the date of 
movement, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

5. Enter optional information in the Comment field. 

6. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

7. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

8. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Retired / Slaughtered' file 
Follow these steps to create a CCIA 'Retired / Slaughtered' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account code for where the animals are being retired 
(maximum 20 characters, numeric or uppercase).  

Notes:  

The data is retained in this field once it has been entered for the first time. 
The CCIA issue an Account ID to each registered user. You will need to be a 
registered member of the CCIA to receive this code. 

3. Click the Date Retired drop down arrow to select the date of movement, 
and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Creating a CCIA 'Sighted' file 
Follow these steps to create a CCIA 'Sighted' file: 

1. Ensure you have selected the appropriate animals in the MyScale CCIA Utility 
screens.  See Creating a CCIA transaction file (p 74). 

The following screen is displayed: 

 

2. Enter the Source Account and Source Premise of the animals 
destination, (maximum 20 characters, numeric or uppercase). 

Notes:  

The data is retained in these fields once it has been entered for the first 
time. 

The CCIA issue an Account ID and Premise ID to each registered user. You 
will need to be a registered member of the CCIA to receive this code. 

3. Click the Date of Sighting drop down arrow to select the date of the 
sighting, and click on the up or down arrow to select the time. 

Note: A date later than the current date cannot be selected. 

4. Enter optional information in the Comment field. 

5. Check the Open CLTS website on finish, if you want to open your web 
browser and display the CLTS website once the file has been created. 

6. Click Finish. The CCIA transaction file will be saved, and the path where the 
file is found will be displayed.  

The check box Copy the path to the clipboard for me is checked by 
default.  This will enable you to 'Copy' the path into the web‐site without 
having to 'Browse' for the file. 

7. Click OK. If you have left the check box Open CLTS website on finish, 
checked, the CLTS website (www.clia.livestock.ca) will open in your web 
browser. Login using your CCIA username and password, then follow the on 
screen instructions to upload the file you have created. 

This requires Internet Explorer version 4.0 or higher. If you do not already 
have it, you can download and install Internet Explorer from the Microsoft 
website ‐ http://www.microsoft.com/windows/ie/downloads/default.asp 
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Using Tag Bucket files 
Ensure you have completed steps 1 to 4 of either; 

Creating a CCIA transaction file (p 74) or  

Creating an NLIS transaction file before continuing: 

1. If you selected  , the screen changes to the following: 

 
MyScale Pro uses the Tag Bucket files listed in the right hand pane to obtain 
the visual tag number for each Electronic ID. 

If the Tag Bucket file(s) do not contain the Electronic ID, MyScale Pro uses 
the visual tag numbers contained in the session file instead. 

Adding a Tag Bucket File 

To add a new Tag Bucket file to the list: 

 Click Add.  
 A 'browse for folder' dialog box displays.  

 Use the dialog box to locate and click on the Tag Bucket file.  

 Click Open.  

Removing a Tag Bucket File 

If you want to remove a Tag Bucket file from the list: 

 Click on the file and then right‐click within the pane.  A drop‐down menu 
displays.  

 Click Delete.  A confirmation dialog box displays. 

 Click Yes to confirm the deletion. 

2. Once all the Tag Bucket files that you want to use are listed in the right‐hand 
pane, return to Step 5 of  

Creating a CCIA transaction file (p 74) or 

Creating an NLIS transaction file, depending on the type of file you are 
creating. 
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I&R/ VKI UPLOADER UTILITY 
In the Netherlands there are two national databases which all sheep and goat 
owners must be registered with and which they are  legally required to keep 
updated. 

These are: 

 The Identification and Registration database (I&R) which is operated and 
maintained by the government's Ministry for Agriculture, Nature and Food 
Quality (LNV). 

 The Voedel Keten Informatie database (VKI) is run by an agricultural board. 

MyScale Pro can output a .csv file that contains the data to be used as the basis 
of information transfer to these two databases.  

When Netherlands is chosen as the selected country during a Myscale Pro 
installation, an additional option is added to the Scale, Dairyscale or Reader tabs 
– Open I&R/VKI Updater. 

This utility is used to update the "I&R" or VKI central databases (in The 
Netherlands) by sending selected animal's information to a specified web server.  
The Utility language can be changed between English and Dutch. 

The I&R database requires: 
 Each sheep and goat must be electronically tagged within 3 days of birth.  

 The animals must then be registered to a site (e.g. farm, marketplace, 
slaughterhouse) in the National Identification and Registration database.  

 Every site where an animal is allowed to be has a unique registration number 
called the UBN (Unique Farm Number).  

 When an animal is born, or transported to another site this must be 
registered in the I&R database. 

The VKI database requires: 
 Each sheep that goes to a slaughterhouse must be accompanied by a 

declaration of the sheep's state of health and the site it came from. 

 Update the "I&R" database with selected animals and user entered 
information, and receive/display a returned result 

 Update the VKI database with selected animals and user entered 
information, and receive/display a returned result 

 View a history of past I&R transactions, with the option to withdraw an 
update for an animal. 
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Using the I&R/ VKI Uploader Utility 
When Open I&R/VKI Updater is selected from the MyScale Pro main menu, the 
following window is displayed:  

 

To update a database, select the required Database option and click Next. Refer 
to Selecting animals to send to database (p 95), for further information. 

To view details of a file uploaded to a database, select View I&R Database 

History and click Next. Refer to View History (p 101) for further information. 

To set up default settings for your farm, click on Account Settings. Refer to 
Account Settings (p 94) for further information. 

To change the language on the Utility, select the flag in the top right corner of the 
screen, that corresponds with the required language. The selected language is 
highlighted with a light blue box. The currently selected language is remembered 
if the application is closed and re‐opened. 
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Animal Utility ‐ Account Settings 
When the Account Settings button is selected from the main menu, the following 
screen is displayed: 

 

1. Complete the details in each field as required. 

Field Name Description 

Organisation  Enter Organisation number. This is used 
as a default value whenever the 
application requires it. Field length is 20 
digits. This field can be overwritten. 

Farm Number  Enter your Farm Number. This is used as a 
default value whenever the application 
requires it. Field length is  12 digits. Note: 
the VKI database only allows 7 digits. This 
field can be overwritten 

I&R UserName  Enter your numeric User code. This field 
is restricted to 20 digits 

VKI UserName  Enter your alphanumeric User code.  

Password  Enter the passwords assigned to your 
User Names 

2. Click OK once fields are completed.   
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Selecting Animals to send to database 
If you selected Update I&R Database or Update VKI Database, the following 
window is displayed: 

 

1. Click on Select files containing session data, and a default MyScale Location 
folder will open.  

2. Select one or more animal files (csv fomrat) and click Open. 

3. Select the required animal records. 

You can select the files in the following ways: 

 Click on the check the box next to the required animal(s). 

 Click on the required record and highlight the line, then click the Select 
button. 

 Hold down the control key and click on each record required then click 

the Select button. 

4. Once all animals have been selected, click Next. 

Note: To deselect a selected file, click on the required line to highlight it and 

click Unselect. 

What happens next 
If creating a file for the I&R Database, go to Creating an I&R Registration file (p 
96). 

If creating a file for the VKI Database, go to Creating a file for the VKI Database (p 
99). 
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Creating an I&R Registration file 
Once you have completed the steps from Selecting animals to send to database 
(p 95), the following screen is displayed: 

 

Follow these steps to create a Registration file: 

1. Select the required file type from the Please Select Type drop down 
menu.The fields on the screen will change to match the type selected. Refer 
to Registration files for the I&R Database (p 97) for further information. 

2. Enter or select data in the relevant fields. Reer to Registration Type fields (p 
97). 

3. Once all fields have been entered, click Next.  

The Summary/Confirm screen is displayed showing the count of animals that 
will be sent and a list of each animals session, Electronic ID and Tag Number.  

4. Click on Upload to send the data to the selected database. 

When the Upload is finished, the screen changes to display the total animals 
sent, the total of animals updated successfully and the total of animals that 
failed to send. 

5. Click View History to view details of sent files, see View History (p 101).  

6. Click on Finish. 

7. Click Close to exit the Animal Uploader Utility and return to MyScale Pro. 
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Registration files for the I&R Database 
The following types of registration files can be uploaded to the I&R Database. 

I&R transaction file 
type 

Used to indicate... 

Birth Registration  the actual birth date or beginning of season 
for the selected animal type 

Arrival Registration  if animals have arrived onto your property 
from another property 

Departure Registration  if animals have left your property and gone 
to another property 

Export Registration  if animals have been moved outside the 
Netherlands border 

Import Registration  if animals have been brought from outside 
the Netherlands border 

Death Registration  any animals died within the Netherlands  

Refer to Creating an I&R Registration file (p 96) for further information. 
 

Registration Type fields 
 

Registration type 
fields 

Description 

Organisation  Populated from data entered in Account Settings (p 94). 
This can be overwritten or data entered if displayed as 
blank 

Farm Number To  

(Uniek Bedrijfs 
Nummer) 

For animals coming to your farm enter your farm 
number. Populated from data entered in Account Settings 
(p 94). This can be overwritten or data entered if 
displayed as blank. 
For animals going to another farm (Export, Departure) 
enter the number of the farm they are going to. 

Farm Number From: 

(Uniek Bedrijfs 
Nummer) 

For animals coming to your farm, enter the number of 
the farm the animals have come from. 

For animals going to another farm, enter your farm 
number. Populated from data entered in Account 
Settings. This can be overwritten or data entered if 
displayed as blank. 

Date of Birth  Defaults to today's date, this can be overwritten to actual 
date. 

Date of Death  Defaults to today's date, this can be overwritten to actual 
date. 
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Registration type 
fields 

Description 

Animal Type  Select animal from drop down list. 

Arrival Date  Enter the date the animals arrived on your farm. 

Date of Departure  Defaults to today's date. Enter the date the animals left 
your farm. 

Date of Import  Defaults to today's date. Enter the date the animals were 
imported. 

Country of Departure  Enter the country name where the animals have come 
from. 

Date of Export  Defaults to today's date. Enter the date the animals were 
exported. 

Send Transport Details  Check this box if transport details are to be included in 
file. 

Name  Enter transporter name. 

License plate number  Enter license plate of transporter. 

Relation Number  Enter number up to 20 digits. 

Departure Time  Enter departure time of transporter. This will default to 
the current time. 

Expected Duration (hrs)  The expected length of the journey. 
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Creating a file for the VKI Database 
Once you have completed the animal selection steps from Selecting animals to 
send to database (p 95), a series of 10 questions are displayed. 

1. Answer each question selecting either Yes or No. 
 If you answered Yes to questions 1 – 4 the Add Animal Treatment 

screen will be displayed. See Add Animal Treatment (p 99) for further 
details. 

 If you answered Yes to questions 5 – 9 you must enter relevant 

information in the Please Specify field and select Next to continue. 
 Question 10 requires veterinarian details to be entered.  

 If you answered No to a question, select Next to continue. 

Once all questions have been completed, the VKI Animal, User and Signature 
Details screen will display.  

2. Enter the required information and select Next. 

The Summary/Confirm screen is displayed showing the animals and their 
Electronic ID/Tag number in a list view.  

Notes:  

 The Name field will default to the Farm number entered in the Account 
Settings screen. 

 Place, Name and Initials of Signatory must be completed and the 'filled in 
truthfully' check box must be ticked to make the Next button active.  

3. Select Upload to update the animals to the VKI Database. 

When the Upload is finished, the screen changes to display the total animals 
sent, the total of animals updated successfully and the total of animals that 
failed to send. 

4. Click View History to view details of sent files, see View History (p 101).  

5. Click on Finish. 
 

Add Animal Treatment 
When Yes is selected from the VKI Food Issues Information screen questions 1 – 
4, a panel similar to the following will be displayed. 

 

1. Click on the + button to display the Add Animal Treatment screen. 



   3E2398  MyScale Pro W610 User Manual 

 

Page 100 

 

The Animal Treatment window will display fields as per one of the following: 

 
 

 
2. Click on the down arrow on the Animal ID field to select an animal. 

3. Enter the required information into the fields. 

Note: Where a date field is required, this will default to today's date and 
may need to be overwritten. 
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View History 
History information of uploaded files, can be viewed from either the main menu 
on the Animal Uploader Utility or from the final screen when files have been 
Uploaded to the database. 

From the Registration History you can either: 

 View  details of an uploaded file 

 Withdraw an animal from the I&R database. 

 

1. From the main menu select View I&R History.  

The Registration History screen is displayed showing all files sent in the last 7 

days. Select Show All if you wish view to all history files. 
2. The top list view shows some information for each transaction, including the 

date/time, transaction type, number of animals sent, the organisation and 
unique farm number.  

A tick or cross is shown for each row, indicating whether or not all animals 
were sent successfully. A cross is displayed if at least one animal failed. 

 
3. Click on the line you want to view, so it is highlighted. The lower list view will 

now display the details of all the animals sent to the I&R database in this file 
including;  

 The session each animal was seen in 

 The animal's two letter country code 
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 The animal's 12 digit animal id 

 The animal's tag number, if one exists 

 The returned registration number for this animal 

 If the animal failed for some reason, the error code and error message 

 

4. For further details of the selected file, click Show Details. The 
Registration Details will be displayed. 

 

Click OK to return to the I&R History screen. 
Or: 

To withdraw an animal from the registration file, select an animal record in 
the lower list view. 

Follow the instructions to continue. A withdraw transaction will be sent to 
the I&R web server. A new entry is added to the history with the type 
"Withdraw". If successful, a blue tick will be displayed next to the record. 

5. Click Finish to close the window. 
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SESSION STATISTICS 
You can view the statistics of both standard and trait sessions retrieved from the 
Weigh Scale.  You have to first download the required session. 

 

Sessions initiated by the Weigh Scale 
With sessions initiated on the Weigh Scale, you can calculate the statistics of: 

 a session; or 

 selected records of a session. 

Using the statistics window, you can experiment with 2‐way and 3‐way drafting 
to see how animals could be drafted. 

 

Sessions without drafting 
To calculate statistics, follow these steps. 

1. Open a session file. 

Note: The session file must not include drafting limits.  See Sessions with 
drafting (p 105). 

2. If you want to view statistics for less than the total number of records in the 
session, select the required rows. 

3. Click  . 

Statistics display as shown in the example window. 
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4. If you want to see how animals might be drafted two or three ways, select 

either   or  . 

 

5. Type different values in the Drafting Limit(s) text boxes to see how 
drafting numbers could change. 

6. Click on OK to close the statistics window. 

Notes 

 Any drafting limits you set or statistics you view in MyScale Pro are not 
transferred when you copy the session file back to the Weigh Scale. 

 You cannot save drafting limits you set or statistics you calculate. 

 To print the statistics, select File > Print with the Statistics window open. 
 To move to another window in the MyScale Session Editor, click on it.  Click 

on the statistics window again if you want to edit or close it. 
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Sessions with drafting 
To calculate statistics, follow these steps. 

1. Open a session file. 

Note:  The session file must include Drafting limits.  For sessions without 
Drafting limits see Sessions without drafting (p 103). 

2. If you want to view statistics for less than the total number of records in the 
session, select the required rows. 

3. Click  . 

A screen similar to the following displays: 

 
Note: For this statistics screen to display: 

 The session must have drafting turned on, and 

 drafting limits can not be altered during the session. 
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If the drafting limits are altered during the weighing session, the following screen 
displays: 

 
 

Creating a weight gain graph 
The MyScale Session Editor lets you create a weight gain graph for any animal. 
You can use weights recorded in session files or draft lists. 

 

Before you begin 
Before you create the graph you will need to: 

 Copy sessions from the Weigh Scale to the computer for at least two 
different weighing sessions that contain a weight record for the animal. 

 Open all the sessions that contain weight records for the animal in the 
MyScale Session Editor. 

 Check that the Visual Tag Number (Tag number) or Electronic ID, 
whichever you are using to identify the animal, is the same in all sessions. If 
it is not, you need to edit the records that are different so that MyScale Pro 
recognizes which weight records apply to this animal. 

 

Procedure ‐ Creating a weight gain graph 
To create the weight gain graph: 

1. Click on the weight record of the animal that you want to display the graph 
for. You can do this in any of the open session files. 

2. Click  . 
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3. Depending on the options you have selected previously, the following screen 
may display. 

 
 Click Yes to open other session files before creating the graph. A file 

open dialog box displays. You can select one or more session files to 
open. 

 Click No to create the graph now, using the session files that are 
currently open. 

 Check   if you don't want this message box to display the 
next time you create a weight gain graph. 

4. MyScale Pro creates and displays the weight graph for the animal. 

 
 

Notes about weight gain graphs 
 The graph shows both the absolute weight at each session (the line) as well 

as the average weight gain between two sessions (the bars). 

 The average weight and the average weight gain figures are calculated using 
the date the animal weighed rather than the session date if it exists else the 
session date is used. 

 The weight units (lb or kg) displayed are set in the Tools > Weight Units 
menu option. 

 The name of each session file that contained a weight record for the animal 
displays on the horizontal axis. The sessions are spaced so that they 
represent the actual amount of time that elapsed between sessions. 
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 The weight gain between two sessions (in /day) is displayed on the weight 
gain bar. The height of the bar indicates the average daily weight gain 
between the session before and after the bar. For example, the tallest bar 
indicates that on average the animal gained weight the fastest between the 
session before and after this bar. 

 You can save or print the graph. Select File and then Save or File and then 
Print, respectively. Graph files are saved by default to the 
MyScale/Graphs folder. 

 You can open a graph file in the MyScale Session Editor. Select File > Open 
Graph. The graph files saved in your MyScale/Graphs folder displays. 
You can select a graph file from this folder or use the browse facility if you 
have saved the graph to another folder on your computer. 

 You can create a graph of average weight and average weight gain between 
sessions. Select more than one (or all) animals in one session and click the 

 Button. The resulting graph represents the average weight by session 
and the average weight gain between sessions for all open sessions. This is 
useful for seeing the overall growth of a particular herd or mob of animals, 
regardless of whether each and every animal was correctly weighed and 
recorded in every session. 
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EMAILING SESSION RECORDS 
 

Emailing session files 
This feature enables you to email the currently open session to a user defined 
email address. 

To email an open session file: 

1. Select File > Email Session. 

The following screen displays: 

 
Complete the fields as required.  

Field Description 

From 
Address: 

Enter your Email address.  Automatically populated with the 
last email address added. 

To Address:  Enter the Email address to which you want the sessions to go. 

SMTP 
Server: 

This stands for Simple Mail Transfer Protocol. To find your 
STMP Server, see Finding your STMP Server (p 110). 

User ID:  This is the ID that you enter when signing into your Email 
account. Often this is memorised by your computer and rarely 
has to be manually entered. Instructions include how to find 
your User ID, see Finding your STMP Server (p 110).. 

Email 
Subject: 

Automatically populated with the name of the session file you 
are sending. 

2. Click Next. The session file you selected is emailed to the "To Address". 
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Finding your STMP and other email account details 
To find your SMTP Server you need to open your email program. Here is an 
example of how to find the SMTP Server in a common email program such as 
Microsoft Outlook Express. 

1. Select Tools > Accounts. 

 

This opens a screen called Internet Accounts. 
2. Select the Mail Tab. 

 

3. Click Properties.  
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The SMTP address displays in the "Servers" Tab. Your User ID is in the 

Incoming Mail Server in the field labelled Account name: ("breeder" 
in the example shown). 

 

4. Once you have recorded the required details, click Cancel to close this 
window. 
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